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Getting started with PSOC™ HV PA family

About this document
Scope and purpose

AN230264 briefly introduces you to PSOC™ high-voltage (HV) precision analog (PA) family, an Arm” Cortex -M0+
based microcontroller. This application note also guides you to set up the PSOC™ HV PA development
environment.

Intended audience

This document is intended for anyone using PSOC™ HV PA family MCUs.
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1 Introduction

1 Introduction

This application note provides an overview of the device feature set, and describes the development
environment and tools to get started with the CY8C41xxLCE-HV4xx series from the PSOC™ HV PA family. PSOC™
HV PAis a fully integrated programmable embedded system for battery monitoring and management. The
system features an Arm’ Cortex” MO+ processor with programmable and reconfigurable analog and digital
blocks. The PSOC™ HV PA will be offered in a 32-QFN package with wettable flanks. To get a better
understanding of the functionality described and terminology used in this application note, see "Section A:
Overview" of the architecture technical reference manual (architecture TRM) [2].
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2 Feature set

2 Feature set

PSOC™HV PAis a fully integrated programmable embedded system for battery monitoring and management.
The system features an Arm’ Cortex” M0+ processor, and programmable and reconfigurable analog and digital
blocks.

PSOC™ HV PA devices have these characteristics:

«  High-performance, 24 to 49.152-MHz Arm" Cortex’ MO+ CPU with MPU and DMA controller
+  Precision analog channel subsystem (PACSS)

«  Highvoltage subsystem (tolerant up to 42 V)

+ Integrated LIN transceiver

+  High-precision clock sources

+  Configurable Timer Counter PWM (TCPWM) block

«  Configurable Serial Communication Block (SCB) with 12C, SPI, UART, and LIN slave operating modes
+  Low-power operating modes: Sleep and Deep Sleep

+  Functional safety for ASIL-B according to 1SO 26262

«  Automotive Electronics Council (AEC) AEC-Q100 qualified

Figure 1 shows the major components of the PSOC™ HV PA architecture.
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Figure 1 PSOC™ HV PA block diagram
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2 Feature set

2.1

Function summary

+  32-bit CPU subsystem

Up to 49.152-MHz Arm’ Cortex” MO+ CPU with MPU and DMA controller
Up to 128 KB of code flash with ECC

Up to 8 KB of SRAM with ECC

Up to 8 KB of data flash with ECC

+  Precision analog channel subsystem (PACSS)

Two precision delta-sigma ADCs (16-20+ bits)
Current channel with automatic gain
Voltage channel

Temperature and diagnostic channels

Digital filtering, accumulators, and threshold comparisons on all channels

+ High-voltage subsystem

Operates directly off 12 V/24 V battery (tolerant up to 42 V)
Integrated LIN transceiver
HV input divider for voltage channel

«  Functional safety for ASIL-B

Development process of ISO 26262 for ASIL B

Memory protection unit (MPU)

Challenge-response watchdog timer (CRWDT)

Overvoltage protection (OVP) and brownout detection (BOD)
Hardware error correction (SECDED ECC)

Analog diagnostics

+  Timing and pulse-width modulation

Four 16-bit TCPWM blocks
Center-aligned, edge, and pseudo-random modes
Quadrature decoder

+ Clock Sources

+2% up to 49.152 MHz internal main oscillator (IMO)
+1% 2 MHz High-precision oscillator (HPOSC)
40-kHz Internal low-speed oscillator (ILO)

+5% or 7% 32-kHz precision low-power oscillator (PILO) based on the part number

« Communication

SCBs with re-configurable 12C, SPI, UART, or LIN slave
LIN interface compliant with LIN 2.2 A and ISO 17987 standards
Up to 8 GPIOs

+ Package

32-QFN with wettable flanks (6 x 6 mm)
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3 Development environment and tools

3 Development environment and tools

3.1 Evaluation board

The CYHVPA-128K-32-001 Evaluation Board (Figure 2) provides access to all peripherals, resulting in a fully
featured evaluation platform. CYHVPA-128K-32-001 has Arm’ standard MIPI 10-pin / 20-pin connectors for the
debug interface by third-party interfaces, and Infineon KitProg3 low-level communication interface for
programming and debugging. The evaluation board can be used for the development of software. For more
information on board details, see the PSOC™ HV PA Evaluation Board user guide [4].
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interface
Input _ l
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Resistor Connectors Connectors (100m/75m /50 m/4.02 Q) Temperature eset Switc for DUT header for
(100 /50 pQ) (Upto6A) Sensor PSOC™5LP
Figure 2 CYHVPA-128K-32-001 Evaluation Board - top view

Figure 3 shows the CYHVPA-128K-32-001 Evaluation Board block diagram.
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Figure 3 CYHVPA-128K-32-001 Evaluation Board block diagram
3.1.1 CYHVPA-128K-32-001 board connections
Table1 Board connections
CY8C4147LCE-HV413 (U3) Connection/component
Pin Pin name
1 VDDA Internal analog power (3.3 V): 0.15 uF capacitor
2 VSSA Analog GND
3 RSH2 100 ./ 50 uQ shunt resistor
4 RSH 100m/75m /50 m/4.02 Q shunt resistor
5 RSL 100m/75m /50 m/4.02 Q shunt resistor
6 RSL2 100 ./ 50 uQ shunt resistor
7 VSSA Analog GND
8 VREFH 0.47 uF capacitor + side
9 VREFL 0.47 UF capacitor - side
10 VTEMP_RET Thermistor or potentiometer

(table continues...)
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Table1 (continued) Board connections

CY8C4147LCE-HV413 (U3) Connection/component

Pin Pin name

11 VTEMP Thermistor or potentiometer

12 VTEMP_SUP 33 kQ resistor

13 VSSD Digital GND

14 XRES Reset switch / program connector

15 PO[7] SWDCLK for programming

16 PO[6] SWDIO for programming

17 PO[5] User push switch /1/0 header

18 PO[4] User DIP switch / 1/O header

19 PO[3] User LED (green) / 1/0 header

20 PO[2] User LED (red) / 1/O header

21 PO[1] I2C SDA / UART TX/ 1/O header

22 PO[0] I2C SCL / UART RX / I/O header

23 VCCD Internal digital power (1.8 V): 0.15 uF capacitor
24 VDDD Internal digital power (3.3 V): 0.1 uF, 3.3 uF capacitors
25 VSSD Digital GND

26 VSSL LIN GND

27 NC1 -

28 LIN LIN connector

29 NC2 -

30 VDIAG VBAT voltage sensing with 2.2 kQ resistor (for diagnostic)
31 VSENSE VBAT voltage sensing with 2.2 kQ resistor

32 VBAT 12 V power supply input

- EPAD Heat pad (GND)

3.1.2 Connection diagram with tools

PSOC™ HV PA has an SWD interface to connect with third-party debuggers. The debug pin of SWD is shared with
the GPIO port (P0[6] and PO[7]). For more information, see AN230265 - Hardware design guide for PSOC™ HV PA
family. Figure 4 and Figure 5 show an example of the basic connection for PSOC™ HV PA devices. Note that the
external resistors are optional.
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Figure 5 Basic connection diagram of MIPI 20-pin connector
3.2 Automotive Peripheral Driver Library (AutoPDL)

Automotive Peripheral Driver Library (AutoPDL) provides ISO 26262-compliant low-level drivers for all PSOC™4
HV peripherals.

The development environment officially supported by AutoPDL is IAR EWARM. To use EWARM, obtain the
appropriate license. See Peripheral drivers for information regarding the software and license.

3.2.1 CPU (CMO0+) startup sequence for PSOC™ HV PA

The following steps are involved in the device startup sequence:

1. System reset (at 0x0000 0000)

2. CMO0+in SROM/boot

3. Device in privilege mode

4, Perform trimming of the device based on the 64-bit key

5. SWD initialized

6.  APIsexecuted from Arm”’ CMO+ NMI

7. APIs for the flash program, erase, and read

8. APIs to retrieve data from privilege registers

9. Transfer control to the user program

Application note 9 002-30264 Rev. *C
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10. Device in user mode
11. CMO+ executes the user application from the code flash region
The following steps are involved in the application startup sequence:

1. System reset (at 0x0000 0000).

2. CMO+ executes "Systemlnit"

3. Disables WDT

4, Applies flash wait states

5. Clock selection

6. Enables generic system IRQ

7. Continues execution of CMO+ user application
3.2.2 Startup flow example

The application startup sequence process is executed after the boot process completes. In the boot process,
according to the lifecycle stage, protection status and debug access restriction settings are mainly performed,
and application authentication is performed. In the application startup sequence process, initial settings
necessary for program execution such as disabling the WDT, applying flash wait state, and clock settings are
completed, and then execution jumps to the main routine. CMO+ executes the boot code after reset.

Figure 6 describes the PSOC™ HV PA device startup flow.
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Figure 6 Device startup flow
Note: See the architecture TRM [2] for more details on lifecycle stages and protection bits.
3.2.3 Sample code

Code Listing 1 Sample code for CMO+ startup and Code Listing 2 Sample code for CMO+ main function show a
sample code for the CM0+ startup and main function respectively.
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Code Listing 1 Sample code for CM0+ startup

;************************************************************************

;¥ Start-up Code
;************************************************************************
THUMB
PUBWEAK Reset_Handler
SECTION .text:CODE:REORDER:NOROOT(2)
Reset_Handler:

; Disable global interrupts
CPSID I

; Update Vector Table Offset Register with address of user ROM table
; (will be updated later to user RAM table address in C startup code)
LDR r@, =__vector_table
LDR rl1, =VTOR
STR ro, [ri]
DSB

; Initialize ECC of startup stack (needed for local variables in C startup code) by processing
bytes per loop iteration,

(o]

; Prerequisite: Stack Pointer (SP) has not been modified (from the vector table init value) by
above code (otherwise code must be adapted)

MOVS ro, #0 ; clear value

MOVS rl1, #@ ; clear value

LDR r2, Cy_u32StartupStackStartAddress
startup_stack_ecc_init_loop:

STM r2!, {ro, ri}

CMP r2, sp

BNE startup_stack_ecc_init_loop

; Call C startup code (no ANSI C context established yet!)
LDR r7, =Startup_Init
BLX r7

; Initialize data sections
LDR r7, =__iar_data_init3

BLX r7
LDR r7, =__iar_program_start
BLX r7

; Note: Control flow does not necessarily return here.
; On some tool-chains (e.g. IAR) control flow will never return from
; the system library.
Cy_Main_Exited:
B Cy_Main_Exited

Application note 12 002-30264 Rev. *C
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Code Listing 2 Sample code for CM0+ main function

#include "intrinsics.h" /* To use IAR embedded function */
#tinclude "startup.h"

#include "bb_bsp.h"

#include "cy_common_def.h"

#include "cy_error_callout.h"

#include "cy_gpio.h"

#include "cy_sysclk.h"

#tinclude "cy_syslib.h"

int main(void)

{

uint8 flag = 1;

SystemInit();

__enable_interrupt(); /* Enable global interrupts. */

/* Initialize USER LED1 port/pin */
Cy_Gpio_SetPinMode(CY_USER_LED1_PORT_IDX, CY USER_LED1_PIN, CY_USER_LED1_MUX);
Cy_Gpio_SetDriveMode(CY_USER_LED1_PORT_IDX, CY_USER_LED1_PIN,
CY_GPIO_DRIVE_MODE_STRONG);

/* Initialize USER LED2 port/pin */
Cy_Gpio_SetPinMode(CY_USER_LED2_PORT_IDX, CY_USER_LED2_PIN, CY_USER_LED2_MUX);
Cy_Gpio_SetDriveMode(CY_USER_LED2_PORT_IDX, CY_USER_LED2_PIN,
CY_GPIO_DRIVE_MODE_STRONG);

for(;;)

{ // Wait @.05 [s]

Cy_SyslLib _DelayUs(560000);

switch(flag)

{

case 1:

Cy_Gpio_Inv(CY_USER_LED1_PORT_IDX, CY_USER_LED1_PIN);

flag = 2;

break;

case 2:

Cy_Gpio_Inv(CY_USER_LED2_PORT_IDX, CY_USER_LED2_PIN);

flag = 1;

break;

default:

Cy_Gpio_Inv(CY_USER_LED1_PORT_IDX, CY_USER_LED1_PIN);

break;

}

}

}

3.3 Peripheral drivers

Peripheral drivers are a set of firmware drivers that provide APIs for accessing hardware. These APIs perform
initialization and control activities of each peripheral.

Table 2 lists the peripheral drivers that Infineon provides for SDL, and Table 3 lists the device-specific
middleware.

Application note 13 002-30264 Rev. *C
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Table 2 Peripheral drivers list

No. |Driver Description API functionality

1 ADC Analog to Digital Converter Manage ADC operations

(PACSS)

2 CPU CPU driver Enable CPU-specific features

3 DMA Direct Memory Access Perform memory-to-memory (M-DMA) and peripheral-
to-memory (P-DMA) (and vice versa) operations

4 FLASH Flash APIs to handle flash memory

5 GPIO General Purpose I/O Ports Configure and access device input/output pins

6 LIN Local Interconnect Network Provide master and slave data transfer capabilities

7 SCB Serial Communication Block Manage serial communication as 12C, SPI, or UART

8 SYSCLK System Clock Provide APIs to control and read the status of various
clocking capabilities of the device

9 SYSINT System Interrupt Manage interrupts and exceptions, in conjunction with
the CMSIS core NVIC API

10 SYSLIB System Library Utility functions to handle delays, register read/write,
asserts, silicon unique ID, and more

11 SYSPM System Power Modes Control device power modes

12 SYSRESET System Reset Provide APIs for reading reset reasons and clearing
them

13 SYSTICK Systick Timer Manage a 24-bit down-counter timer

14 SYSWDT Free-running Watchdog timer | Provide control and status capabilities

15 TCPWM Timer Counter PWM Manage a 16- or 32-bit periodic counter, PWM,
quadrature decoder, shift register

16 TRIGMUX Trigger Multiplexer Manage the multiplexing of trigger outputs to specific
trigger inputs across multiple peripherals

Table 3 Device-specific middleware

No. |Middleware |Description API functionality

1 COM UART Com Configuration UART configuration for ADC example projects

2 ADC PACSS/ADC Counts to Volts APIs for converting ADC counts to volts and millivolts

3.4 Example usage of AutoPDL with IAR

34.1 Environment for AutoPDL

This section describes the operation with PSOC™ HV PA devices with AutoPDL as an example.
AutoPDL Operational Conditions:

« CPU:PSOC™HV PA devices (32-QFN)

+  Target board : CYHVPA-128K-32-001 Evaluation Board

002-30264 Rev. *C
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« IDE:IAR Embedded Workbench for Arm"8.50.10
+ ICE:IAR I-jet Debugger or onboard KitProg3

3.4.2 Install IAR Embedded Workbench and AutoPDL

Install IAR Embedded Workbench 8.50.10 in advance and ensure that the licenses are properly enabled.
The following sections provide information on the installation procedures and licensing details for AutoPDL.

3.4.2.1 Download AutoPDL package and license

Follow these steps to download AutoPDL and get the License.

1. Go to Infineon Developer Center.

2. Under Software, find PSOC™ 4 HV Family AutoPDL and middleware and click on Request to get access
to the AutoPDL software.

Once the order request is approved, you will receive an email from Infineon Developer Center (R-1FX-

DeveloperCent@infineon.com). Product installer key (License Key) and a link to download the software will
be included in the email.

(o
MySpace Tools Software
Software
PSoC™ 4 HY Family AutoPDL Doamiosd W
and middleware
Figure 7 Request access to PSOC™ 4 HV Family AutoPDL and middleware
3.4.2.2 Standard installation procedure

After you download the software and extract the archive, follow the instructions to install AutoPDL.
«  AutoPDL Middleware package

1. Run the PSOC4HV_AutoPDL-MW_V1.7.0_Bulkinstall.bat in the \WWxxxx_PSOC4HV_AutoPDL-MW_VX.X.X
folder. After the setup wizard appears, click Next.

Application note 15 002-30264 Rev. *C
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h Setup - PS0C4 HY AUTD POL And Middiewars Package = S

PSoC4 HV AUTO PDL And Middleware Package
Setup Wizard

This will copy P50C4 HV AUTSD PDL And Middeware Package V1.7.0 fles to your
Computar.

Chok Next to combrue, or Cancel to ekt Satup,

2, Enter the License key which is including in email from Infineon Developer Center and click Next.

g Setup - PSol4 HY AUTO POL And Middieware Package - b4

Software license hey
Please erber your 16-tgis heense key.

Formnak: M000C- D000 X000 30000

License loey:

ELLL L LY LN III

[ St password

N e [

3. Read the license agreement. Select | accept the agreement and click Next.

16 002-30264 Rev. *C
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ghy Setup - PSoC4 HY ALITO POL And Middbeware Package - =

License Agreement
Pease read the folloveng rmpotant nformaton before contnung.

Pease read the folowng Lcense Agreement. You must accept the terma of ths agreement before contmung with
the nstalation.

DRIVER EVALUATION SOFTWARE LICENSE AGREEMENT I

BY INSTALLING OR HAVING INSTALLED THE SOFTWARE, LICENSEE AGREES TO BE BOUND
BY THE TERMS AND CONDITIONS OF THIS AGREEMENT IF LICENSEE DOES NOT AGREE TD
ALL TERMS AND CONDITIONS OF THIS AGREEMENT, LICENSEE (INCLUDING YOU) SHALL
NOT USE THE SOFTWARE BUT IMMEDIATELY DELETE IT (TO THE EXTENT THAT IT WAS
DOWHNLOADED ALREADY)

THIS AGREEMENT SHALL APPLY TD THE EXTENT MO SEPARATE SOFTWARE LICENSE
AGREEMENT REGULATING THE COMMERCIAL USE OF THE SOFTWARE (AS DESCRIBED
BELOW) IS IN PLACE BETWEEN LICENSOR AND LICENSEE, IN WHICH CASE THE TERMS
AND CONDITIONS OF SUCH SOFTWARE LICENSE AGREEMENT SHALL PREVAIL OVER THIS
AGREEMENT

1. DEFINITIONS

© 1 accept the agresment
11 do not accept the sgresrment

4, Read the information and click Next.

| by Setup - PSaC4 HY AUTO FDL And Middievwars Package - : *

I Indoarmat o

When you are ready to contiue wih Setup, ceo Next,

Infinean Technologies AG
Embedded Soltware Database

®  When continuing this program, you will be asked for an installation folder

& You can select any modules and documents to install.

=  If old version of modules and documents exist in the installation folder, they will be replaced 1o new one
In the installation process. in this case, the Information of esisting modules and documentations to be
replaced {removed) is displayed in advance, Please dick 0K button te continue the installation process if
wou can accept the replace (removal) of existing contents.

5. Select the install folder and click Next to continue.

Application note 17 002-30264 Rev. *C
2025-02-14



o~ .
Getting started with PSOC™ HV PA family In f| neon

3 Development environment and tools

[ 2hg Setup - PSoC4 HY AUTO POL And Middiewars Package *

Select Location of Embedded Software Database
Where should drivers from Infineon Technologies AG be copied?

|_]J Please select the location to install PSaC4 HY AUTO PDL And Middleware Package V1.7.0 files.

To continue, cick Mext, If you would ke to salect & different base folder, click Browse,

CHTMFIMECH_AUTI_SWAPSaC4HY_POL_MW_V10700 Browes .

AL ezst 31.9 MEB of free disk space is required.

L

6. Select the components that you want to install and click Next to continue.

. 2z ;
¢y Setup - FSoC4 HV AUTO PDL And Middleware Package - X

Select Components
Which components should be nstalled?

8 buk select al codes
8 buk select al documentatons

[Driver] ADC V1.2.0
: | i'm'-;]' e Unlicensed Components cannot be selected

B code |
B documentanon
[Driver] CTB V1.0.0

.
r

[Drwer] OFL V1.0.0
nde

8 pocrera —* |Check box
[ =DMA V1.1.1

B code

B documentation
[Driver] FLASH V1.0.2

B code

. docurmnentaton

Hack | MNext Cancel

Application note 18 002-30264 Rev. *C
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7. The Auto PDL and middleware package installer checks for the existing Auto PDL drivers/
middleware and documents in the installation folder. The existing drivers/middleware and
documents are displayed. If you want to replace the existing contents, click OK.

"y Setup - PSoC4 HV AUTC PDL And Middleware Package = x

Existing Contents tobe Replaced
Are you sure you want to replbce the folowng exstng contents?

Clck DK if you agree the replacement of the folovang exstng contents, or cick Back if you want to revew or
change any setungs.

Fomponents to be replaced:
Hothing

User Guide to be replaced:
Nathing

Release Notes to be replaced:
Kothing

Badk I 0K Cancel

8. Confirm the details and click Install.

Application note 19 002-30264 Rev. *C
2025-02-14



o .
Getting started with PSOC™ HV PA family Infineon

3 Development environment and tools

1 cby Setup - PSoC4 HV AUTO POL And Middlsware Package - X

Ready to Install
Setup & now ready to begin instaling FSoC4 HV AUTO PDL on your computer,

Chick Install to start mstalation, o dick Badk if you want to review or change any settngs.

Destination location;
| C:\Users\RauSiddhesh Desktop\Project2\PSoCAHV_PDL_ MW (2) i

Common componants:
[Component] COMMON:
- Code: common
= Document: UsersGuide_Common_1_0_PSoC4HV _POL.pdf
ReleaseNotes_Common_1_0_PSoC4HV_PDL.pdf

[Component] USERENVY:
- Cnde; useranv

Selected components:
[Dwiver] CPU VL. 1.1

9. Read the Precautions for Use and click Next.
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- .

by Setup - PSoC4 HV AUTO POL And Middleware Package -

Information
Piease read the folowng mportant mformaton before contnung. r__*

When you are ready to contmue with Setup, cick Next,

Precautions for Use

= Combination of the modules that are contained in different package version is not allowed,
e g Combination of EEPROM in PDL package V1.xx and FLASH in PDL package V1.2.2

| s Installation of device header file iz required to build PDL

Wext

10. Click Finish to complete the installation.
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. = i
by Setup - PSeC4 HV AUTO PDL And Middleware Packsge E

Completing the PSoC4 HV AUTO PDL And
Middleware Package Setup Wizard

Setup has mshed mstaling PSoCE HY AUTO PDL And Mddieware Padkage on {
VOLF COPMpUbEr |

Chck Finish to exk Setup,

+ Device Header Files
1. The setup wizard for device header files is automatically appeared.

2. In the setup wizard, click Next.

3. Read the license agreement. Select | accept the agreement and click Next.

4, Read the information and click Next.

5. Select the install folder same as selected while installing the Middleware. Click Next to continue.
Application note 22 002-30264 Rev. *C
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| I'i'l Setup - PSoC4 HY family Device Header Files Package — -

Select Location of Embedded Software Database
Whare chould drivars from Infinaon Technologies AG be copied?

"E Pleasa specfy the falder where PSol4 HY AUTO PDL And Middlewzre Package is installzd.

To continue, cick Next. If you would like to select a different base folder, dick Browise.

CHINFINECHN_AUTO_SVEPSoC4Ry_POL_MW_V 10700 Erowea...

At lzast 0.0 MB of fres disk space & reguired.

Back Cancel

6. Select the HV Device for which you want to install headers and click Next to continue.
| ri‘l Satup - PSoC4 HY family Device Header Files Package = X |
Salect Components
Which components should be installed?
Select the components you Want To instaly dear the components you de not want to install. Cick Mext when you are
ready to continue.
Full Instzliation
ﬂ PSoC4 HY family Device Header Hles Package V1.7.0
i B psocdhumstdk
B psocdhvms1 28k
B psocdhvpalddk
- B psocdhvpaspmc
Current salection raquires at laast 6.2 MB of dick spaca.
Back Mext Cancel
7. Check your selection and click on install.
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3 Setup - PSoC4 v family Device Heade [ ="

Ready to Install
Satup is now ready to begin insling PEol4 HY family Device Header Fles Packzge an your computer.

Click Install to continue with the installhton, or click Back £ you want to review or change any settings,

Destnation location:

CHINFINEDN_AUTO_SWHEPSoCARY_PDL_MW_VLO700 f

Setup type:
Full Instalation

Solectad components:
P5oC4 HV family Device Header Fles Package V1.7.0
psocd hvmsad
psocthvms1 28k

peocdhvpalddk
psocdhvpaspmc |

pack Conce

8. Click Finish to complete the installation.
« Code Examples
The setup wizard for code examples automatically appear.

1. In the setup wizard, click Next.

2. Read the license agreement. Select | accept the agreement and click Next.

3. Read the information and click Next.

4, Select the install folder same as selected while installing the middleware and device header. Click

Next to continue.
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£ Setup - PSoC4 HY family AutoPDL Code Example Package

Salect Location to Install
Where should example programs from Infineon Technologies AG be copied?

'_‘E Pleasa spacfy the folder whera PSoC4 HY AUTO PDL And Mddlewara Package is installad.

To continug, clck Mext, If vou would lke to select a diferent base foldar, cick Browse.

CHMFTEON_AUTO_SWAEPSoCaHY_PDL_MWW_V10700 Browee. .

AL least 9.4 MB of free dick space is required.

5. Select the HV Device for which you want to install code example from the drop down as shown in the
following figure. Click Next to continue.

| ri‘l Setup - P3oC4 HY family AutoPDL Code BExample Package — bt

Salect Installation Type
Which components should be installed?

Salect tha Installztion Type from the pul-down menu below: Click Next when you are ready to continua.

Full Instzliation
Instaltion for HVMS-64k
[nstallation for HYMS-128k
Installation for HYPA-144k
[nstalation for HYPA-SPM-C
psocthvms128k 1.4 MB |
psocthvpalddk 1.5 MB |
{ psocdhvpasprc 1.2 MB
> adc 0.2 MB
> capcanca 0.2 MB
i oipi 0.1 MB
devices 0.2 MB
dma 0.1 MB
EEprom 0.1 MB
flash 0.1 MB
&+ gpio 0.1 MB
i i 01 MR
Current szlection requires at least 34.0 MB of disk space.
Back Mext Cancel
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6. Check your selection and click on install.

gl Setup - PSoC4 HV family Aut

Ready to Install
Setup 1s now ready to begin instaling PSoC4 HY family AUTOPDL Code Example Package on your COMmpUTer.

Click Install to contnue with the ins@liztion, or cick Back if you want to review or change any settings.

Destnation loction:
CH¥INFIMEOMN_AUTO_SWY¥PSol4HY_PDL_MW V10700

Setup type: i
Full Instaliztion |

Selected components: |
PSoC4 HY family AutoPDL Code Example Packzge V1.1.0 |
examples |
Tools i
IAR_EWARM_Patch_PSoC4HV
psocdhvmsedk
psocdhvmsl 28k
psocdhwpal44k |
| psocdhwpaspmec |
| adc
| capsense
cpl
devices
drma
EE0rom
flash

Back Cancel

7. Click Finish to complete the installation.

3.4.2.3 IAR EWARM flash patch configuration update

Copy and paste (or replace) the flash loader files (arm folder) to the IAR installation folder.
1. Copy from AutoPDL installation:

. C:\INFINEON_AUTO_SW\PSOC4HV_PDL_MW_Vxxxxx\examples\Tools\IAR_EWARM_Patch_PSOC4HV
2. Paste (or replace) to IAR installation:

. C:\Program Files (x86)\IAR Systems\Embedded Workbench 8.4 EWARM FS 8.50.10

IAR_EWARM Patch PSal * Embedded Workbench B. X +

& CAINFINEON_AUTO_SW\PSoC4HV_PDL_MWexamples\tocls\IAR_EWARM_Patch_PSoC4HV|

ki CAINFINEON_AUTO_SWAPSOCAHV POL_MW\examples\tools\IAR_EWARM _Patch PSoC4HV
3 New

P Pictures
O Musc
O videos

Embedded Workbench @ *

C\Program Files (xBEAAR Systems\Embedded Workbench 8.4 EWARM FS 8.50.10

CAPragram Files (x86J\AR Systems\Embedded Workbench 8.4 EWARM FS B.50.10

— Note : Please merge the folder into o e
destination folder, Do not replace/delete the files.
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3.4.3

Example usage of AutoPDL

1. Navigate to the AutoPDL folder and open the PSOC4hvpal44k_Eva_license.eww file.
C:\INFINEON_AUTO_SW\PSOC4HV_PDL_MW_Vxxxxx\examples\Tools\PSOC4hvpal44k

Note: If you use the source code license, open the PSOC4hvpal44k_flash_cmOplus_template.eww.
psocahvpalddk + B = S
« 3 T c [ » - examples » Tools > psocdhupatlddk > Search psocdhwpal &
f:::i New E Ll_J IE__ 2 E,T Tl Sort = \iew e [ Details
P9 Pictures * 1 Mame Jate modified Iype .
9 Music + Debug : 24 ! er
n Videos » sel‘tings P 2 A e fokder
Tools " [ main_crnOplus.c 202410403 15:23 C File
[ psocaHvPA_ 144K 24/10/03 15:2 CF File
INFINEOMN_AUTO SW _
[ psocdhvpal4dk_Eva_license.dep 24 16:42 DEP File
psocdhvpaspmc :
| 7 psocahwpatadk Eva license.owd 241041 ) EWD File
Screenshots - ) , I i
[ psocdhvpalddk_Eva_Rcence.owp 202471041 .23 WP Fila
psocthvpaspme [ psocdhvpalddk_Eva license.owt 202410403 15:23 WT Fil=
Hsereny |l¢ psocdhvpalddk Eva_license 2024710403 15:23 1AR IDE Workspace
devices [ psocdhvpalddk flash_cmiplus_template.dep 4 [ .23 P File
[ psocahvpatddk_flash_conlplus_template.ewd 241041 } N File
~ [ This PC O psocdhvpalddk_flash emlplus templateewp 20241000 2 WP File
v B Windows (0 [] psocdhvpatadk flash_cmilplus_template.ewt 24/10/0 ! WT Fi
@ psocdhvpalddk flash_cmlplus_template 202410403 15:23 AR IDE Workspace

J i Nabwork

17 Iems 1 item selected 179 bytes

2. Double-click on main_cmeplus.c in the left panel. Details of the sample code are shown (see Code Listing

2).
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@ peocdhupaldds Eva license - IAR Embedded Waorkbench |DE - &rm 850,10 = (] H
Fil=  Edit ‘iew FProject CMSIS.DAP Tools ‘Window Help
T_l ﬂ d ﬂ H o' -. [ lo G -4 O 2 B -E < # U |_L . . = o i ut: =
Workspace * B x| main_ondplusc x M
.DE‘:I.IQ . 'F'::'
o =TT Y
L]
Files ¥ arile Zain Efplug.o
El @ psocdhvpnl 44k_Eva_license- ...

" abriet

* Mein file for CMU+

(W5 B mrin_cmOplus o

3 [ stausn_cmiplus s .
L= & Dutaut

de =atartup.h™
= "bix_bap.h"

pracihvpal4dk_Eva iceree

Euild

Wessages File

Source Browse Log  Build Debug Log

3. Write the Define value for your target device.
e.g. C:\INFINEON_AUTO_SW\PSOC4HV_PDL_MW\source\userenv\cy_pdl_config.h
The device names supported by the standard evaluation board are as follows:
« HVPA144K: CYS8C4147LCE_HV423 (Evaluation board) or CY8C4147LCE_HV413 (Lite-Kit Board)
« HVMS64K: CY8C4146LWE_HVS115
« HVMS128K: CY8C4147LWE_HVS135X
« HVPASPM-C: CY8C4147LDE_HV734
If you are using a Lite-Kit board, please also add the following definitions.
«  HVPA144K: KIT_PSOC4_HVPA_144K_LITE
« HVMS128K: KIT_PSOC4_HVMS_128K_LITE
If you are using HVPA-144K_LITE, change it as follows:
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| main_cmiplus.c  cy_pdi_configh x

fi===mmmmmm e [ N1 NS 1 00E ] a

B i b
H /% Specifiss the psage device.
! Please refer the cy device headers.h 1in desvices/<device name> folder to determine the symbol. 4/
f/fderine CYBCS147LDE BVT34 /¢ HVPA SPM-C '/
SAgderfine {.‘:’E‘C(lé?.’.i‘:_:iﬂ-'h'l_?ﬁ.'f F4 HVMSIZER 4f
#define CYSC414TLCE_HV423 /¢ RVBALSSK '/
S/fdafine CYBCS146LNE HVS11E /* EVMSG4E °/
$define KIT PSOCH_HVPA_144K_LITE
/4 Specifies use of Software Error Report or not.
= SIE CY_WT. Softvare Error Report will be callad vhen development error such as parameter srror is dstected. ¢
#define C¥_PDL CONFIG_SW_ERACH REPORT (CY_ON)
/t Specifies the Software Error Report fonction pame. o/
#define CY FDL CONFIG_SW_ERROR REPORT_FUNC (Cy Pdl_SwErrorReport)
J4 Specifies the Hardvare Error Report function name. o/
#define CY_FDL_CONFIG_HW_ERROR_REPORT FUNC (Cy Pdl HwErrorReport)

rE ¥

[type dafinitions]

f e ey bernal  fonctlon declaraki one]

Simszaa

fendif /¢ (fifndsf C¥ PDL CONFIG H) o/

R L g e —

4, Select Project > Rebuild All to build the project.

ﬂ psocdhvpalddi_Eva_license - 1AR Embedded Workbench IDE - Arm 8.50.10 - (m] b4
Fle Edit View [Project| CMSISDAP Tk Windaw  Helg
i " s - -
a0 [& AddFiles... BACG 2 SELDIHNE RBs 0 - TiET
4 s o
Workspate [ Add Group.. e —— =
41| import File List I
Detus £ § _ fo
= 1 Add Froject Connadtion i/
las YN
Edit Condigusstions._. \[ile main ceiplus.c
E @ psocdhvpe ¥ ‘
I‘m = ¥ | Remove * vhrief
E]m s ¢ Main fils for CMO+
Bl startup.c | T2 Create Mew Project... .
Bl starup_c . add bxistin B R A E A E AR EEA R R
EX = @ Project...
L@ i Output + \eopyright
£ options... A7 | ¢ Copyright 2022-2027, Infinecn Technologies. All rights ressrved.
* ¥You may ose this file oply in accordance with the license, terms, corditioms,
Version Controd System p| * disclaimers, apd limitabions in the end wser license agrespsnt accompanying
¢ Ehe poffware packags vith which ERils file waz providsd.
[ A T P P PR PSR T PR TR TR LTI LY
B compile Cirl=#7 -
2 dincluds "inrinsics.h™ /¢ To use IAR smbedded fonction
finclude “aTarTuR.h"
#include “bb_bap.h”
Eatch build... F
& ® | iincluge "oy _common_def.h"
#include “cy_error_callouc.h”
C-5TAT Static Anadysis ® = -
#inclode “cy gpic.h®
£ | stop Buitd Ciri=Ereaw | #include "oy sysclk.h”
finclude “cy_syslib.h™
O Download and Debug Cn=p
R A AR E B AR AR AR AR
¥ Debug without Downdoading :
4 dl PIS-Prods £ /
) Attach to Bunning Target T T T T T TP T PR T T RTR T
G- Mske & Reitart Debugaer Chik=R
poocinpalddk B -~ | peian Denugger Qrleshittsn [
Buitd | Downidoad * -
Meszages SFR Setup File
pEacdivpal|
i I M
Comerking w5 CMSI5-Pack Manager
Farforming F Open Device Descriptson File L]
Serve List of Registers...

Total numberurerors
Tokal numiber of wamings: 0

Source Browse log  Build Debug log
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Note: Ifyou didn’t request a SafeTlib license, two errors will occur. If you see the errors, remove
the cy_pstl_user_callout.c and libpstl.a files and then select Rebuild all. To remove the
cy_pstl_user_callout.c file, right-click the file and then click Remove. To remove the libpstl.a
file, navigate to Project > Options > Linker > Library tab and click the ellipses button next
to the Additional libraries pane. Select libpstl.a and click remove (x).

@ psocdhvpaspme_Eva_license - IAR Embedded Workbench |DE - Arm 850,10 = ] *

File Edit “iew Froject CMSIS-DAP Tag Miodoae Sl

DNORE & XKE D =005l
Wores pace -
Debug iy
Fil=s F - S
B @psocdhvpaspmc_Eva_license -De... ¥ $include "intrinsics.h™ /% To use TAR embecded fuanction 4/
== I.._ #include "startup.h™
Lom. $include "Hb_bep.h"
o,
| I—E| H:ource tinclude "cy_common_def.h"™
| |_E| B usereny #ineclude "oy srror _calleutc.h®
| |— i b #incluge “cy gplo.n™
| Fm e =hE — #lpclude "cv sysclk.h”
| L@ L] ov_ser_callodc Uptionz.. alib.h"™
L& & middlewares . . o e S e
R R ol Compile orsssor symbols/macros ('#d=fins')
_E mﬂ"—l_cmpuSE n ARRASRRERE S ERAS R R AN ERAE R R R EERRE AR EARR LI RRE SRR IR RS
8 [ startup.c Rebuild &
& [ =startup_cmiplus.s
T . Cutput o xarole for GPIO to blink all 1Z0a,
C-STAT Static Analysis 3 uz 2 LED perts on the CPU board.
I procéhvpasome Eva license
Add 3
Build - 0
I Remove I
ldes=nges -
Tatal numiseraf errors: 1 Version Control System y |
Total number of warnings: [
Open Contzining Folder...
File Properties...
Build Debuglog
Remave selected item SER s e Varnings 0 Ln 22, Cal 23 System | CAP MUMW OVR BES
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@ psocdhipaspme_Eva_licensz - IAR Embedded Warkbench IDE - Arm 8

*
File Edit View i CMSIS-DAP  Tools  Window  Hel H
P Remove libpstl.a
o B @ | L AddFies.. =
[ — ] p
Warkspace [a Add Group... _pe S Factary Settings
"bebug [+1| import File List... N Genﬁral Options
= Add Praject Cannection... Static Analysis
les ) ) ) Runtime Chedkn
=X Jpsocdhvpd Edit Configurations... C/C-++ Compil N Hdefing Diggnostics ~ Checksum  Encodings  Extra Options
ompiler r
|_E| ] o Config Input Optimizations ~ Advanced Output  List
| I_L:_‘ . ¥ | Remove Assembler
- Output Converter @ Automatic runtime librai i
= ry selection
| W.. |10 create New Project... Custom Build
| s . . Additional libraries: (pne per line)
r’ Add Existing Project... i T
| | Lg SPROJ_DIRSY. ¥ ¥ ¥source¥lib¥psocdhvpaspmc¥libautopd .a D
| | l_ £ Options... Alt=F7 SPROJ_DIRS%. ¥ ¥ ¥source¥lib¥psocdhvpaspmclibpst.a
| | L& ebugger
| = #de Version Control System 4 Simulator
CADI () Ovenide default program entry
CMELS Db . Entry symbol __iar_program_start
GDB Servy R . X R
. Edit Additicnal Libraries
Iget
IHink/1-T
T Stellary | Library
Nu-Link FEBOJ_DIR$S. 5 Ssourceblib\psocdhvpaspmehlibautopd]. &
PE micro | s tPROJ_DIR &
ST-LINK <Click to add>
Third-Par{

5. Connect the USB cable to the J4 and 12V wall Adapter to the J22 of the CYHVPA-128K-32-001 Evaluation
Board with the power supply (See Figure 8). See the PSOC™ HV PA Evaluation Board user guide [3] for
more detailed information.

12vwall
Adapter

J22 SW5 D12
Power
Connector

4 BATTERY .

MINUS
Sty
-

SHUNT SETTINGS

=11

Pec S17
i

Figure 8 USB cable connection
6. Download the project to PSOC™ 4 HVPA-144K device by selecting Project > Download > Download active
application.
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ﬂ peocdhvpal 44 _Buva license - |AR Embedded Workbyanch IDE - Aam 850010 = O b
File Edit View | Project | CMEIS-DAR  Toole Window Help
D E M (G saare 2 QK=< R A0 R®= 0 il
\Warkspace E: Add Groug. . 1 cmilplus.c  x -
Diebuag [4]| impodt File List. .F”
) Add Prajedt Cannedian.. . | Jeddddddageang RENNAAAddd I I RRRALN RENENAAddd I I RRRALN RENENAAddd I I RRARLN RENNRAAdprdd
File Edit Configurations ‘ hfile main emiplus.c
G @ psocdhvpe ! -
= X | Remowe ¢ \brlef
0] main_cr| i Mein fil= for CMI+
Bl startupc [T Create Hew Froject.., .
|_E Elitnrrup_: _I: Add Bisting Brgjet.. | e R R
|—E|-Clutput Y \copyrignt
O pLians. At-F7 | * Copyright
' Yom may n , -
Wersion Control System k imora, and limitstiona 1 paer 11 & agrecment decoEpanying
roftvars packags with vhic
B ke F7 b iadsiiiiiniiii BEABdddd R EEE
B comgie Cti=F7 _ o _
#include "intrinsice.n” /4 To wse LAR embedded funcbicn #
- Rebuild 411 #includs "startup.h”
& cClean #include “bi_bap.h”
1] I
& | Batch buid.. L $include *cy_coonon_def.h"
C-5TAT Statle Aralyss v $#include "cy_error_:zll:ut.h"
+includs --l_".'_ﬂl_'.‘:'_tl-'l’."
0 | stop Build Ctil=Ereak fincluds "cy_sysclk.h"
$include "oy apalib.h"
I Download snd Debug Cirl=D
R
* | Debug withaut Downloading s sor symbols/macros ('#defin=*)
/% Local 5 symbols/macros ('#d=fip=*] E
) | AHach to Funning Target fasssasiansnas NANNMMMsdssiERRELE NANNNMMddssEERELE NANENEssasssEEEEEE T
| — Make & Restart Debugoer crrl+A |
DSIJDEI‘NDEI'I-!II!K_E\-‘ Restart Debugger tri=5Shift+
Build I Drerinilaad k Drowinload adive application I w 00X
fss Bigas SFR Setup Uownload Me Fila
Erase memory
=0 cdhvpal
EUI'IUEI“TI] mb CMSIS Pack Manager
Parfarming H Cpen Devce Description File L4
Save List of Registers.,
Totsl numb erorerorso
Total number clwarnings: 0

Source Browse Log  Buid  Debug Log

& Ciovanload the active application tothe target withollt launching a Tull debug s Errars O, Warnings 0 Ln 36, Cal 1 System  CAR MUR OWR -_=
7. Push the reset switch (SW2) on the CYHVPA-128K-32-001 Evaluation Board and then confirm that the LED
D6 and D7 are blinking.
+ Download the application using the IAR I-JET debugger
Note: If you do not have the IAR I-jet Debugger, then skip Steps 8. to 10..

8. Connect the IAR I-jet Debugger to either J3 (MIPI 20-pin) or J5 (MIPI 10-pin) of the CYHVPA-128K-32-001
Evaluation Board with power supply (See Figure 9). See the PSOC™ HV PA Evaluation Board user guide [4]
for more detailed information.
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12V Wall
Adapter

J22 SW5 D12
Power

Power
Connector

Switch

MBEDDED IN TOMORROW

& CYPRESS

B PR - |

d
m;:ﬁgv I [ u3
; SHUNT SETTINGS ; i PSOC™ 4 HV PA
o - DUT)

i )
cones- s 3.
oC { PA BO )
. gevoz

]

PC
y
Debugger
J5 . . J3
MIPI 10-pin ,° . MIPI20-pin

Connector b. ‘a Con'nector

i
4 [ Mor

4
uSER LEBS

Note:

Application note

Figure 9 Connection of IAR I-jet Debugger

Please check I-jet is set for Debugger. In case of the CMSIS DAP program, the menu name shows
CMSIS DAP. Ifit isn’t, navigate to Project > Options > Debugger and select I-jet at Driver.
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a procdhvpalddk_Eva_license - R Embedded Workbench IDE - Arm B.30.10 -

Save List of Registers...

File Edit  Wiew CMSIS-DAF Taols Window  Help
P G e aedFiles,
Wakspare C8 Add Group...
i M imgort File Lisk
Dabug [+ port File Lisk...
Add Prajed Cannedian..,
Fil== Edit Canfi 1]
afigurations. .
o e
|_m . ¥ Femowe
El main_cm
[ stertupe [T Create Haw Projert..,
tg El storiup_c| 8 aog Existing Frojec..
B Cutped
£ Options.. Alt-F7
Werspon Control System L}
B rake F7
. Compile Ckrl=F7
B Rebuild Al
& Clean
& Batch build... FE
C-5TAT Static Analysis ]
B stop Build Cirl-Break
@ Downlcad and Debug cti+o
¥ Debug vathout Downlosding
®]  Attach ta Running Target
Make & Restart Debugger Cirl+R
peocdinpal Ak_Ev Restart Debugger Chri=Shift=F,
Build Download ]
tessnyes SFR Setup
p=ocdhvpal
) 15-F
Convering g CMSI5-Pack Manager
Perormming A Open Device Desiption File ¥

-~
>

4 Qo2 < Q30 BB= 0 &

¥

emdlpluse = -
iy

T T
i %file main cedplus.c

i

4 ybrief

v Main Cils for M0+

P e e e e e T e T P I T P e

+ ycopyright

i Copyright 2022-202%, Infin=on Technologis=s. All rights ressrved.

+ Yon may U8 thig r1ls anly in dccordshos wikth bhe licsnss, btsrma, conditlong,
v dipelaimers, abd 11mitations IR the and nasr licohfe agrecsment Jccompan
4 the softvars package vith vhick this file was provided.
R R R R R R R R R

g1

#inlude
ginclude
ginclude

"intringicve.h® /' T pee TAR wodwdkded fuoclion #
=scartup.h”

*bb_kap.h®

#include
#include
ginclude
ginclude
#inclade

"oy common_def,h™
"oy erEoE_calloat.h”
"oy _gpic.hk”
“cy_ayaclk.h™
*oy_syalib.h*

R

defins ) Y

S-PLOCSSSST SYRDOLE/MACTES

R

Total nurmberoremorE
Tolal number of warmings: 1

File

Source Browese Log  Build Debug Log

. Edit options tor the selected hem
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| @ psocdtvpa 144k Bva license - AR Embedded Workbench IDE - Arm 850,10 O et
File Edit Wiew Project CMSIS-DaP Tools  Window  Help
MinES = 480 oc | Sle gy K< QoA BBE0 - S
Warkspaoe * 4 X main_omibplusc = -
Dabug ¥ fis
I L e T T P PR PR R T
Files @ - * 4file main cmiplos.c
=] psocdhvpal 44k_Ewve_lic B
@l Cipticres for node *psacdhvpalddk_Eva_license™ b4
@ E rein_criplus o
& B statup.o
FEES'EIMD_D’T]UDMSS 1 G A RAAG AR AR R
L -_ClLITFILIt Category Factory S eliings
General Optiora =d.
Stabic Analysic ms, conditicns,
Runtime Chadk £ accompanying
e "o Seup Downiead Images Mutikors  Bxra Oplione Plugine
EAZ+ oo AR A AR Ay
smerhler Dirtwr BFunto
CUtput Corverter :
Custom Buid e man
. mudgtor
| | Buid Actions canl
] EEEL CMSIS DAP
| Sm
| | = Lk
n
CHSIS DAP PE micro
GOB Seruver ST-LINK
Thirc-Party Criver .
[t YIS Y
K T M3F-FET B :
JHinkj]-Trace TI =05 SoebuggertinfineoriST Y BCA 147LCE
[ —— TTTITTIIIITLY,
. Hu-Lirk
paccdbivpal 44k Eva iznze EE mioo
T 1 STLINK E .
= S| Thedparty Diver L
Wessages e [ 1
14 Cancal
peocAbnpal4ak_Eva_license
Corering
FPetarming PostEuild Action
Total nurmber of armare: 0
Total number of warnings: 0

Source Browse Log  Build Debuglog

. Ready Emors 0, Warnings 0 Ln 36, Cal 1

System  CAF RUM OUVE =

9. + Download the project to PSOC™ HV PA device by selecting Project >Download > Download active

application.
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10.

11.

infineon

@ peocdbvpal4dk_Bva_license - AR Embedded Workbench DE - &rm 8.50.10 - a et
File Edit View | Project Tool: Window Help
00 M@ | Do s e 2 QOSECROOF R®=0" [idl
Workspace [& Add Group.. LCmopius.c i
Debun 21 impart File List... fo
F| Add Project Connection... [ fossssssasasasansnnnnns T T
les EAE1E mEim g Lug. e
Edit Corfigurations.. \fil2 main cmOplus.c
= @ psocihvpd :
. ¥ | Remave ' \brief
8] main_cm| ¢ Mzin fils oy CMD+
2 B stertuppc |10 Create Mew Project... !
|_Eg_s1mp—':'—dAddEnisl:inngjut... e BRI R R RERERE R R R R A SRR R R RERERE R R R A SRR R R 0
L& o Cutput
&  Opticn:... Ait+F7
! You may u@e s file N,
Varsinn Contral Spstem p| ¢ dizcleimsrs, and L
' the softears package w. Rhis Tils vas provided.
. Make 123 S N TRy P ARG A AR R AR RN RN AR A AR A A SRR NI N
B compie Ciri=F7 )
#include "INtrinalca.h™ * To use IAR embaddsd functicm
- Rebuild Al #lnclude "scartup.h”
# Clean $includs "bb bep.h®
Bateh build. . FB
ij " §ioclude "cy_common_def.h”
C-STT STAtIC ANa sis »| #include "cy_error_callout.h”
tloclude y_gelo.a”
B} Stop Build Ctri-Break | #imclude "cy_sysclk.h®
#include "cy_ayalib.h™
o Dawnload and Debug Chrl+D
AAAAAAG G MM ERERIERE AARRALAAAAAA B4 dIAERERINEf
*  Debug without Downloading o ) ) o [, °
Bl pPre-processor ST macros | 'éd=fin=")
©]  attachto Running Target ELRRE R A A AR R AR AR A AR NN R AR AR Ry
kake B Restart Debugger Chil=R i
[ pencatvpstath_Ev Restart Debugge Cerl+Shift+ A |
Build Drawwnload L3 Dowinlaad active applicatian - o
D load file...
Mezssages SFR Setup Frmlaas i File
PROCHNOST| e sis pack Marage S
Corvaring | =2 : '
Farforming H Open Device Description File L3
Save List of Reqgisters. ..
Total numbe rwremors T

Totol numlbaer of wamings: 0

fource Browse Log

| Download the acfive application ta the barget without launching a full debug se

Build Debuglog

Errors O, Warnings O Ln 36 Col1

System | CAP HUM| OuR S

Push the reset switch (SW2) on the CYHVPA-128K-32-001 Evaluation Board and then confirm that the
LED D6 and D7 is blinking.

- Download the application using the onboard KitProg3

Application note

36

Connect the USB cable to the J4 of the CYHVPA-128K-32-001 Evaluation Board with the power supply
(See Figure 10). See the PSOC™ HV PA Evaluation Board user guide [4] for more detailed information.
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12V Wall
Adapter

J22 SW5 D12
Power

Connector

B PsocsLp ®
A Kivrogs | connggtor,

Ll 2
i - 4
YHVPA-128K-32-001 ey -
[ PSoC 4 HV PA BOARD ™ USB cable PC
REV-0 .
—m R ;
]

Figure 10 USB cable connection
12,  Select Project > Options... to change the debugger settings.

File Edit View CMSIS-DAP Tools Window Help

N L B [e Add Files...
: . s
DO
WGIKspatl. E: Add Gmup... 1 Oolus
Debug [___] Import File List...
) Add Project Connectian... | soauna
Tl Edit Configurati g
I onmigurations... s
=P b5 ochvp |
.. Remove ? \bBrl
H& ) main_cm * Mair
I:S ) startup.c | L) Create New Project... ‘
i) startup_c| ' add Existing Project... S
L= i Output ¢ \cop
£ Options... an-F7 |l ' Ceop:
I You
Vinrrinm Fardenl Cunrkam nk o Aiar

13.  Select CMSIS DAP from Options and select the Interface tab. Change the settings as shown in:
+  Probe config -> Auto
« Interface speed -> 2MHz
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Options for node "psocdhvpalddk Eva license
Category: Factory Settings
General Options
Static Analysis
e Ch@m Setup Breakpoints
C/C++ Compiler :
Asiinbler Probe config Probe configuration file
Output Converter Ao gtz
Custom Buid (") Erom file
Build Actions CJ Explicit CRL elect
Linker
Debugger Inteface Explictt probe configuration
Simulator JTAG Multitarget debug system
CADI SWD arget number [TAP or Multidrap D)
Target with multiple CPLs
GDB Server = : : =
Ijet =HOUMORED :
JHinkf)-Trace interface speed
Tt Stelar
Mu-Link
PE micro
ST-LINK
ThirdParty Driver
T sacn e Cancel

14. Click OK and re-select Project > Rebuild All to build the project.
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r ]
ﬁ psuudl'r.-pa'l-ddk_Ew_linerﬂe- &R Em bedided ‘Workkb=nch IDE - S&rm B.50.10 — o 4
File Edit “iew | Frojeck | CMSI5-DEAP  Tools  Window Help

DO R@ | A 1< Q>%rE< 0> RBa0-a]
Workspace Add Greup.. |_cmlpluse -
Dstug mport File List el
.FI Add Project Connection.. P
n=s - - -
Edit Configurakions.. ' Wfile main cmlplos.c
=R psocAbvp: :
ma. e * Zbrief
'—E El main_cm fMain fils for OMO+
3 Bl starup.c Create Mew Project.. .
I—EE!manup_c e e LR ELEEEEEE,
L i Output ' Y\ GOpYELGHT
Options... Alt=F7 ' Copyright 2025-2053, Inrinson Technologiss. ALl rights ressrved.
' Yeu may uge this file cnly im dccordance wibh the licenss, terms, conditions,
Wersion Contral System ¥| * disclaimers, and limitations in the end ussr license agreesmesnt accompanying
' the softvars package vitk whick this file vas provided.
-Mabe F7 T T P P P P
. Campile Chrl=F7 o . o . )
#include "intriomics.h" /* Io pse IAR smbeddsd fun iy
Ehuild 48 #lnclude "atarTap. I
Clean #include "bb_bap.h"
ild...
(TR 53 finclud= "cy_compon_def.h®
C_STT Skatic Analysis p| #include "cy srroc callout.h®
#includ= "cy gpioc.h”
3 stop Build Ctri+Break | #lmelude "oy syvaclk.h™
#include "oy _ayalib.h™
D Download and Debug Cti-D
R R R RN R
rJ Cebiug ifiaut Dounioading 4 acal pre-processar spmbols/macras | fdefine ')
attach to Running Tarpet AR R ARG AR AR AR A AR AR AR ARG A ARAG SR A AR A AR ARG AR ARG AR
L Pake & Restart Debugger Lirl=H
peocdbnpalddk_Ev Restart Debugger Cir=Shift=R
Build Download L] - Qo
hMessoges SFR Setup Fila
psocdhvpal | g
Coreting | ™ CMSIS-Fadk Manager
Fariorming F Open Dewice Desoiption File »
Sanre List of Registers,..
Talal numberoranorso
Total murnkxer of warmings: 0

Source Browwse Log  Build Debusg Log

. Clean and make the adive project Errors O, Warnings & Ln 36, Col 1 System  CAF MUK OYE —

15. Download the project to PSOC™ HV PA device by selecting Project > Download > Download active

application.
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a psocdhypa 144k Bva_license - [AR Embedded Workbench IDE - Arm 850,10 = (] =

File Edit View | Project | CMSIS-DAP  Tools Window Help

‘DO @ [ AddFies. ln 4 QK2 B[N0 RB-=0 08

Workspace [® &dd Group... | omapsusc -

Debug [*] impart File Lisk... fir
Add Frogect Connegtion... :__'u--“u-“u-“u-“u--“u-“u-“u--“u-“u-“u-“u--“u-“u-.-u_-'.a“

Fil= £t Corfigurations #file main cmiplie.c

El i psocdhspe ] -

. X | Remove ¢ ybrier

= 2a]main_cm] 'V Main file for CMD+

@ B statune | T Create Mew Project...

El startup_c % aqd Exsting Project... ! .
& ouiput ¢ yoopyELGhE
& Cptians... AlLTFF 1

n Technolagies. All eights ressried.

licende, Lerma,. o

Version Control System 3 ong IR the ond gesk licenge dgresment 00
4 vhich thiz file vag providsd.
W ek A e R E R TR EERT R
B compile el FT
finclude "intrlnaiea.h™ /" To uze IAR smbeddsd rapction '/
B Reouid 1 finclude "aTarTup.h”
# (Clean #include "bh_bep.h”
= — e finclude "oy common def.h™
C.5TAT Static Analysic | #include BTEME_Callout.h™
#include
B3 | stop Bui ctn+Break | #include
finclude "¢
u Deownlosd and Debug Ckri=D

¥ Debug without Downloading
l':; Attach to Running Targest

Bdakce B Restart Debugger Ctri+R

Cti=5hift<E |

Build I Dowmload k Dewnload active application I * Q=
criflad Tile ...

Messages SFR Setup Fils
Erase memary

psocdtpal g

E—— TSI Pack Manager

F‘|=_Irfc||-ming B Dpen Device Descngtion File 3

Sewe List of Registers.
Tatal numberorerors o

Tatal number of wamings: 0

Source Browse Log  Build  Debug Log

. Dowmnload the active application to the target without launching a full debug s Errars 4, Warmings 0 Lm 36, Call System  CAR MU OVR E

16. Push the reset switch (SW2) on the CYHVPA-128K-32-001 Evaluation Board and then confirm that the LED
D6 and D7 is blinking.

To debug the project using either IAR I-JET debugger or onboard KitProg3 (CMSIS DAP), select Project >
Download and Debug. For more information on debugging, see the IAR EWARM IDE project management
and building guide [5].
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w psocdhvpalddie Bva_license - AR Embeadded Workbench |DE - Arm 8.50.10 - a =
File Edit Wiew CMSIS-DAP  Toaols 'Window Help
amal = F- BRI r<s QR ELG G BB O - S
Workzpace (& &dd Group... _omphus.C % -
.DEH:I.IE m mpart Fila List F[]
Add Prn]gannngcuun__, e R PR L
Files CFl1e mai 5
Edit Configurations... “Aflle maln cmiplps.c
3 @ psocdhvps '
== % | Remave & \hrief
I—E E § Main fil= for CMO+
-8 B aterup o 21 create New Project..,
|—E g_ilﬂl‘ﬂ.lp_t -|’ Add Exsting Project.. rrIIJlJJ.Jrn'rrl B R AR R R R R RN R R
L B Clutt ¢ \espyEight
o Dptions. Alk+F7 ¥ Copyright 2022-2022, Infineon Technologiss. All rights ressresd.
* You may use this rile only in accordanes with the License, t=mms, conditicons,
ersion Cantrol S,’slgm L] f diaplaimexa, aod limitaticns 1n bhe end uasr licends dfiecRenRt dCCOEPaRY1ng
i E roftvare package wabh vhich bhaix file was provided.
B wake F7 AR A R AR A AR R A AR AR R A AR A A RN R AR RRAR R G R R
B conpie Il FT
i tinclude "intringica.h™ /* To pae IAR embeddsd fanctls
B Rebuild Al #loclude "sTartup.h”
# Clean $include "bb_bep.h"
Cestch bulld... ri
i' M tincluds 'CE.’_GM!}!'I._UE‘:.HI'
ST Skakic Analysis ¥ i'j_l'.cll'.d..é 'CE.'_EI"T“QE-_G&].].DU:-.]\."
ticclude “cy_gpic.h”
) Stop Build Cerl=Break $includs "oy _sysclk.h®
#includes 'C}"_ﬁ]’ﬁlib-.f‘l'
Download and Debug Chrl=D
R R P PR PN
» ! :
B [ g Withauk Dovmicading #4 Lorel pre-processcr symbols/ma ['fd=Lfin=*) g
n.:_. Attach to Running Target R P PP P
| Klake & Restart Debugger Cti+R
panctpaTHk EY o | poctart Debugger CUrl+Shift+R
Build | Dawnload » -0 ¥
MMessnces SFR S2tup Fila
e il
CMEIS-Fack kI
Convering & o
Ferfarming F Open Device Description File J
Save List of Registers...
Total numberoremmors g
Total numbar of wamings: 0
Sopurce Browwse Log  Build Debug Log
. Download the application and start the debugger Errors @, Warnings 0 Ln 56 Col 1 System

3.4.4

Other sample codes

The other code examples are in the examples folder.
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(] ,
examples X ar
“— e o O = PSoC4HV PODL MW V10700 > examples 3 Search examples a,
& Pew - Tl Sart - = View - es E Details
[ Mame Date modified Type
@ Desitop # adc 2025/01/22 1320 File folder
2025/01/22 1520 ile folc
L Doumloadc » Capssrise 2025/01/22 15 Filz folder
CIpi 202501522 1520 File folder
| Documents »
dernos 2025/01,22 1520 File folder
P4 Pictures #
devices 2025/01/22 15:20 File folder
O Music * dma 2005/01422 15:20 File folder
B Videos # eeprom 2025,01,/22 15:20 File folder
Tools + flash 2025/01,22 1%20 Filetolder
IMFIREDR_ALTO S * gpi-:- A0S 2L 1520 File talder
i 2025/01,/22 1520 ile fol
peoctiwpaspme » i2c 2025/01,22 1 Filz folder
is0 uart A025/M01/22 1520 Fil= folder
Screenshots »*
lin 202501422 1520 File folder
psocdhypasprme
Ipcamp 2025/01,/22 15:20 File folder
psocdhvpalddk * rricld lewares 2025/01/22 15:20 File foldes
T
24 ems =0

1. Go to any code sample folder (e.g., adc > triple) and copy the main_cmeplus.c file in the folder.
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triple = +
€ T a LJ » - examples » adc > triple
() New ‘Ml Sont = View
@ Music » [ Mame
n Videns @ .ewptoeligners
Tools ’ f | man_cmiplusc  §f
INFINEOM_AUTO_SW & C
opy
procdhvpaspmc »
Screenchots -
psecdhvpaspmc »
psocdhvpalddk »
USEreny
v [l This PC
» = Windows ()
» S Network

2 items

= O X
Search triple a
[T Details
[ate modified
2024/10,/03 15:23
202410002 15:23
El=

2. Navigate to PSOC4HV_PDL_MW_Vxxxxx\examples\Tools\PSOC4hvpal4a4k and replace the copied

main_cmeplus.c file.
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= | =
psocdhvpal 44k * +
€ S (o 1 evamplez » Toole > poocdhwpalddk > Search poocdhvpa O,
iF New Tl Sor = View - [E Details
n Wideos ] Name Date modified Type
Tools Debug 202501724 1512 File folder
INFINEON_ALTO 5w sethngs 2U25/01/22 15:20 File folder
| main_cmDglus.c 202410002 15:23 L File
peocdhvpacpme
PSOCAHVPA 143K icf ICF File
Screenshots
psocdvpalddk_Eva_licence.dep Rep [a ce DEP File
socdhy
psocdhvpaspme psocdhwpzlddk_Bua_licerse. ewd EWW D File
peocdhvpalddl psocdhvpe14dk_Eva_license.enp 2024710703 15:23 EWP Fil=
usereny psocdvpa 14k Bva_licerse.ewt 202410/03 15:23 EWT Fil=
o psocdivpalddk_Eva_licence 2024/10,03 15:23 18K, IDE Waorkespace
v Wl ThisBC psocdhvpe14dk_flash_cmOplus_template.dep DEP File
psocdvpalddl_flash_cmiplus_template.eved EWD File
3 Windows (C) ® F F
peocdiupa1ddk_flach_emOplus_template ewp EWWP Fil=
>l Network -
psocdhwpalddk_flash_emOplus_template evt EWT File
w' psocdvpal4dk flash cmiplus temglate &R |DE Werkspace
17 ikeme E‘ O
3. From the same folder, open PsoCc4hvpal44k_Eva_license.eww (OF

PSOC4hvpal44k_flash_cmeplus_template.eww for source file license) to open the IAR EWARM sample

project.
4, Rebuild and download the project to the board. See the

C:\INFINEON_AUTO_SW\PSOC4HV_PDL_MW_Vxxxxx\examples\readme.pdf file of the sample codes for a detailed

explanation of the use case.

3.5 Development tools

Table 4 Development tool

Vender Emulators/probes Compiler

IAR Systems | -JET Debugger EWARM (8.50.10)
Onboard KitProg3

3.6 Flash programming tools

Table 5 lists the supported flash programming tools. Infineon MiniProg4 programmer is for development
purposes. For mass production purposes, a JTAG programmer from a third-party is suitable.

Table 5 Flash programming tools

Vender Flash programmer Software

Infineon MiniProg4 Infineon Auto Flash Utility

(table continues...)
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Table 5 (continued) Flash programming tools
Vender Flash programmer Software
KitProg3
Note: CYHVPA-128K-32-001 has the Cortex” SWD debug connector. SWD is compatible with MiniProg4.

Table 6 lists the pin assignment for Cortex” debug connector.

Table 6 Cortex” debug connector

Pin Signal

1 VDDD

2 SWDIO

3 GND

4 SWDCLK

5 GND

6 SWO (option)
7 KEY

8 NC

9 GND detect
10 NRESET
Application note 45 002-30264 Rev. *C
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4 Summary

4 Summary

This application note guided you to set up the PSOC™ HV PA development environment. Infineon provides an
evaluation board and a wealth of sample software to help you get started with the PSOC™ HV PA family. To
evaluate the CYHVPA-128K-32-001 Evaluation Board, contact your sales representative or Infineon Technical
Support.
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Table 7 Glossary

Terms Description

A/D converter Analog to Digital Converter

ADC Analog to Digital Converter

AHB Advanced High-Performance Bus
API Application Programming Interface
BOD Brown-Out Detectors

CMO+ Arm’” Cortex’-M0+ (processor core name)
CPU Central Processing Unit

CPUSS CPU Subsystem

DAP Debug Access Port

DMA Direct Memory Access

DMAC DMA Controller

DW Data Wire

ECC Error Correction Code (safety)
GPIO General Purpose I/O

HV High-Voltage

1/0 Input or Output

IAR IAR Systems (Company name)
0SS I/O Sub-System

IRC Interrupt Controller

IRQ Interrupt Request

ISR Interrupt Service Routine

LIN Local Interconnect Network

MCU Microcontroller Unit

MIPI Mobile Industry Processor Interface
MPU Memory Protection Unit

NMI Non-Maskable Interrupt

PA Precision Analog

PACSS Precision Analog Channel Subsystem
POR Power On Reset

PWM Pulse Width Modulation

RAM Random Access Memory

ROM Read-Only Memory

(table continues...)
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Table 7 (continued) Glossary

Terms Description

SCB Serial Communication Block
SDL Sample Driver Library

SPI Serial Peripheral Interface
SRAM Static RAM

SRSS System Resource Subsystem
SWD Serial Wire Debugging
TCPWM Timer, Counter and PWM
WDT Watchdog Timer
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The following are the PSOC™ HV PA family series application notes, datasheets, and technical reference
manuals. Contact Infineon Technical Support to obtain these documents and sample driver library.

[1] 002-28660: PSOC™ HV PA-144K datasheet

[2]  002-29223: PSOC™HV PA architecture technical reference manual (TRM)

[3] 002-29238: PSOC™ HV PA registers technical reference manual (TRM)

[4] 002-29984: PSOC™HV PA Evaluation Board user guide

[5] IAREWARM IDE project management and building guide

[6] 002-31481: PSOC™ 4 HVPA-144K Safety Manual
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Trademarks

PSOC™, formerly known as PSoC™, is a trademark of Infineon Technologies. Any references to PSoC™ in this
document or others shall be deemed to refer to PSOC™.
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Important notice

The information contained in this application note is
given as a hint for the implementation of the product
only and shall in no event be regarded as a description
or warranty of a certain functionality, condition
or quality of the product. Before implementation
of the product, the recipient of this application
note must verify any function and other technical
information given herein in the real application.
Infineon Technologies hereby disclaims any and all
warranties and liabilities of any kind (including without
limitation warranties of non-infringement of intellectual
property rights of any third party) with respect to any
and all information given in this application note.

The data contained in this document is exclusively
intended for technically trained staff. It is the
responsibility of customer’s technical departments to
evaluate the suitability of the product for the intended
application and the completeness of the product
information given in this document with respect to such
application.

Warnings

Due to technical requirements products may contain
dangerous substances. For information on the types
in question please contact your nearest Infineon
Technologies office.

Except as otherwise explicitly approved by Infineon
Technologies in a written document signed by
authorized representatives of Infineon Technologies,
Infineon Technologies’ products may not be used in
any applications where a failure of the product or
any consequences of the use thereof can reasonably
be expected to result in personal injury.
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